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1. System configuration

The system configuration of TOP and “Parker — Compax3" is as follows:

Communication method System setting

RS-232C 3.1 Settings example 1 5.1. Cable table 1
Parker Compax3

RS-485 (Page 4) (Page 8)

W Connection configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/485 communication.
k[=1.]

_
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device H
PLC select [COM2]
Filter : |[AII] v‘ Search :

@ Model (O Vendor
Vendor Model

OMRON Industrial Automation :‘ Compax3

Rockwell Automation

PARKER. HAMMIFIN Corporation

A8D

4_Back | B Next *® Cancel
PLC Setting[ Spectra Series ]
Interface : | Computer Link ~
Protocol : | Compax3 Link ~ Comm Manual
String Save Mode : |First LH HL Change
[ use Redundancy
AND v
Primary Option
Timeout msec
Send Wait msec
Retry 5 =
Station Num
@ Back + OK * Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.

External device | Vendor

Select the vendor of the external device to be connected to TOP.
Select “Parker”.

PLC

Select an external device to connect to TOP.

Interface Protocol

Compax3 Computer Link Compax3 Link

Please check the system configuration in Chapter 1 to see if the external device you want to
connect is a model whose system can be configured.
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3. TOP communication setting
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TO, (|

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Option ¥
[ crenoe ik W Acdpic i T Change PLCIC) [ Delete PLCIDI
‘?'D TOP Setting Date / Time Sync.  Screen Option | Unit Convert
~ . Op'm_” Modle Setting Project Option ~ Screen Change = HmiSetup Global Lock 8 Touch = Project Style = Splash = PLC Buffer Sync.
W™ FieldBus (0)
S
"",.' o (D)g o Initialization Edit
M comz (1) Project Setting ~
@ PLC1: Companc3 (0] HMIDisable=0
--fg# COM3 (0) Project NdamezNaw project
W Ethernet (0) Start Mode=Menu
~{# Wireless () f;at;fﬂ:ig Lol
- USBDevice (0) Latch Set=0~0
Communication Error Message =0
USBErrorMessage=0
StorageErrorMessage =1
DatabaseMessage=1
Control Panel
. | . T E! .
System m Devices :nﬂ Service (= Option
o Serial *
s -
T ) | _
Serial Port: | COMZ =
PLC Security Oat e/ Time .
Signal Level
() BS-232C () Rs-422(4) (@) RS-485(2)
. Baud Rate: 9500 -
M R Rt -
Data Bit: & <
Et hernet Serial HOM | )
Stop Bit: |1 S
— Parity Bit: MNone v
L~ .-\\ Flow: 0ff
L el Ping
iresmes 1 File B Auto Search  Loopback Test
Manager
Apply Cancel
Items TOP External device Remarks
Signal Level (port) RS-485 RS-485
Baud Rate 9600
Data Bit 8
Stop Bit 1
Parity Bit none
* The above settings are examples recommended by the company.
Items Description
Signal Level Select the serial communication method between the TOP and an external device.
Baud Rate Select the serial communication speed between the TOP and an external device.
Data Bit Select the serial communication data bit between the TOP and an external device.
Stop Bit Select the serial communication stop bit between the TOP and an external device.
Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [Project > Project Property > Device Setting >COM > "PLC1 : Parker”]

— Set the options of the Compax3 communication driver in TOP Design Studio.

ERI2 e B X
Touch Qperation Panel

TOP (|

Project Option

- Change HMI[H] ' Add PLC[A] | THiTal Change PICIO | 1] Delete PLCID]

~ [} TOP Setting N
i PLC Setting[ Compax3
i .3 5YS:RD1520% 9l pax3 ]
~ @ Option Module Setting Alias Mame : |PLC1
W FieldBus (0) Interface : | Computer Link ~
8 RFID (0)
Device Setting Protocol : | Compax3 Link i Comm Manual
¥ COM1(0) String Save Mode : |First LH HL Change
e CORD Y
% PLC1: Compax3 [0]
[ use Redundancy
W Ethernet (0) AND ~
Wireless (0) PR : o
.. |JSBDevice (0) - hd
Conditio Edi
Primary Option
Timeout msec
Send Wait msec
Apply Close
Items Settings Remarks
Interface Select "Computer Link". Refer to "2. External
Protocol Select “PC Link".

device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device

and sending the next command request.

Station Num

Prefix
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3.2. Communication setting in TOP
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

e

o

Conit:roll Panel

@ System E D

!lll“
PLC

Serial Port

&

Signal Level

: | com2 -

Security () RS-232C ) RS-422(4) @ RS-485(2) ]
v.“c Baud Rate: [ 9600 l']
ewer ["ﬁ"] o @@l o Data Bit: |8 M
. [T
. Ethernet Serial Stop Bit: [ 1 l']
. . .
Sema A Parity Bit: [None l']
: S een =] : f - g
»‘“@éﬁgn m N Flov: (i M A
| || Diagnostic File [Auto Search] [Loopback Test] V
Manager
[ Apply ][Cancel]
,. [System] —r0Se
Items TOP External device Remarks
Signal Level (port) RS-485 RS-485
Baud Rate 9600 Fixed
Data Bit 8 Fixed
Stop Bit 1 Fixed
Parity Bit none Fixed

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

B [Main Screen > Control Panel > PLC]

(> D TE—

@ Systed Driver(COM2) | PLCI(Compax3) v]
Run EE—
Interface | Computer Link [~]
] Protocol | Compax3 Link [~
PLC Timeout 300 [ msec
: =]
YNC Send Wait msec
Vi
|| D] | P EE
A [~ ]
Ethernet Station b ﬂ
Diagnost ic
[System] l Diagnostic [ App |y HCanceI ]
Items Settings Remarks
Interface Select "Computer Link". Refer to “2. External
Protocol Select "PC Link". device selection”.
TimeOut (ms) Set the time for the TOP to wait for a response from an external device.
SendWait (ms) Set the waiting time between TOP's receiving a response from an external device
and sending the next command request.
Station Num Prefix
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
' . ) 1. System configuration
configuration Connection cable name oK NG
TOP Version information OK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) oK NG L .
diagnostics 3. Communication setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name OK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings OK NG . .
4. External device setting
Serial Parameter Transmission
OK NG
Speed
Data Bit OK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Refer to the vendor’s user manual to identically configure the communication settings of the external device to that of the TOP.
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5. Cable table
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This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagram described in this section may differ from the recommendations of “Parker - Compax3")

RS232 / RS485 interface (plug X10)

m RS-232C (1:1 connection)

COM PLC
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangement*Note 1)
1 5 CcD 1 1 5 1
Q
g 5 sD 3 3 sD ;’ Cﬁ’
Based on DTR 4 4 Based on
communication >G > > 56 communication
cable connector DSR 6 6 cable connector
front, RTS l 7 front,
D-SUB 9 Pin male cTs 8 8 D-SUB 9 Pin male
(male, convex) 9 9 (female, concave)
*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
W RS-422 (1:1 connection)
COM PLC
Pin Signal Pin Cable connection . Pin
Signal name
arrangement*Note 1) name number arrangement*Note 1)
1 5 RDA 1 RXD (2) 1 5
Q 9 3 Q o)

6 9 6 9
Based on RDB 4 RXD/ (8) Based on
communication 5 XD/ (3) communication
cable connector SDA 6 GND (5) cable connector
front, 7 front,
D-SUB 9 Pin male 8 Enable RS485 (1) D-SUB 9 Pin male
(male, convex) SDB 9 +5V (9) (male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

COM PLC
. . . . Pin
Pin Signal Pin Cable connection i
Signal name arrangement Note
arrangement*Note 1) name number )

1 5 RDA(+) 1 TXD RXD (7) 1 5
2
Q o) o o)

3 TXDRXD / (3
6 9 /) 6 9
Based on RDB() 4 Based on
communication G 5 SG(5) communication
cable connector SDA(+) 6 Enable RS485 (1) cable connector
front, 7 +5V (9) front,

D-SUB 9 Pin male 8 D-SUB 9 Pin male

(male, convex) SDB(-) 9 (male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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6. Supported addresses
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Contents Bit Address Word Address RW BIT

R_INT 0000:00.00 — 9999:99.31 0000:00 — 9999:99 R/W 32BIT | 32BIT DATA
R_FLOAT - 0000:00 — 9999:99 R/W 32BIT | FLOAT DATA
R_SHORT | 0000:00.00 — 9999:99.15 0000:00 — 9999:99 R/W 16BIT | 16BIT DATA

® Precautions when using Offset
9999:99

9999 - Index
99 - Subindex

Offset is only applied to Index
Ex) Drawing SYS 100 (=10) as OFFSET on 681.01,
changes the 681.01 tag to 691.01
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Object overview sorted by object name

TO,

WHFUE €3 -
This is the Release 2004R3-1 (as from Firmware V2.05) ADDRESS MAP . For more details,
refer to the PARKER HOMEPAGE

Ma. Chject name Chject FPNU AN Mo Fomnat =C Walid beginning | Devce
a5signment
111 | 20 | 121

G344 C3.AnadogCulpusd DemnandVale Sapaint for anzlog cuput 0 24 2018 (il s Imrnedasly x| X
G354 C3 AnaogCulput1_DemandValue Sepoint for analog ouput 1 103 2020 11 yes Immedately BN
21008 C3.Controller Tuning_CumentBandwidth Cument Loop Bandwidth 4028 21008 16 no WP A O
21002 C3 Controller Tuning_CumentDamping Cument Loop Damping 40248 021008 16 no WP £ |X X
21002 C3.Coniroller Tuning_Damping Damping {rotadon spesd contoler) 4023 21003 16 no WE R |x
21008 C3.ControlerTuning_Finzrboos| Actusl Azosleration Fiter 4028 21005 16 no WP LA O
2100.11 | C3.ConvolerTuning_Fitentccel? Fiter actual acoeleraion 2 16 no VP o O|E | X
21005 | C3.ControlesTuning_FiterSpesd elocity Fiter 4025 021005 16 no WP LA A
2100.10 | C3.ControlerTuning_FiterSpesd? Fiteraciual veloaity 2 16 no WP BN
21004 C3 ControlerTuning_nertiz Moment of inerta 4024 021004 16 no WP £ |X X
2100.7 C3.Coniroller Tuning_SpeedDFacior Velocky Looo - 07 Temn 4027 21007 16 no WE 1R | X
21002 C3.Controller Tuning_Stifness Stfiness (speed controlier) 4022 h2100.2 16 no WE x| X
B20.1 C3.Defay MastrDelay Sepoint delay for bus masier 118 no Imrnediately R |x
1.15 C3.Device_ProflelD Profious profie number Ba5 Qs no - x

1202 C3.Digitanput_Valus Status of digitsl inpues 21 D5100.1 W2 yes - X X |x
112 C3 Digita nputAdditon_Value Inputword of M2 opfion 175 051002 W2 yes - £ |X X
12334 C3.Digita Cuputddd ion_Enable Aciivate inputfoutput opton MO 12 350 30003 W2 no Immediately A O
1332 C3.DigitalOuputAddition_Emor Emorin VD opton 351 3004 W2 no - £ |X X
1333 23 Digita ChuiputAdeidon_Value Cutputword for VO opion 178 083002 V2 ez Imrnediaely X |E |X
5502 C3.EmorHistony_1 Emor (n-1)in fhe emor history B47 1 :201D.2 16 no - X X
2020.1 C3 BvemalSgnal Posion Postion from extemal sgnal source c4a 3 s - x| X
20202 C3 ExiemalZignal_Speed Speed from extemil signa source C4 3 yes - BN
B50.1 C3.FE| RxPD_Mapping_Chject_1 1. Oigject of the sefpoint PZ0 (Profious) B150 16 no Immedately X

BE02 C3.FE| RxPD_Mapping_Chject 2 2. ohject of fie Selpontvaiue PZ0 B151 16 no Immedistely X

BE0.3 C3FB|_RxPD_Mapoing_Chjec 3 3. ohjsef of e Selpontvaiue PZD p1E2 16 no Imrnediaely x

BI04 C3FBl_RxPD _Mapoing_Chject £ 4. phject of e Selpont value PZ0D Bp1E3 U1G no Imrnediaehy x

BE0S C3.FBl RxPD Mapoing_ Chject 3 5. ohjzet of e Selpontvaue PZD Bpr1E4d 16 no Imrnediaely x

BEO0G C3.FE|_RxPC_Mapping_Chjsct 8 f. ohject of fie Selpontvaue PZD B155 16 no Immediztely X

BEOT C3.FE| RxPC_Mapping_Chject 7 7. ohject of fie Selpontvaue PZD B158 16 no Immediately X

BEOE C3.FE| RxPD_Mapping_Chject 8 E. ohject of fie Selpontvaue PZ0 B157 16 no Immediately X

BS1.1 C3FB_TaPD_Mapping_Coject 1 1. chject of acual value PZD B1a0 (W3 1:] no Imrnediaehy x

Bs12 C3FB_TaPD_Mapping_Object 2 2. ohjscf of acual value PZD B 16 no Imrnediaely x

BE1.3 C3FBL TaPD_Mapping_Object 3 3. ohjzef of acual value PZD a2 16 no Immnediaely x

BE14 C3FBlL TaPD_Mapping_Object 4 4. ghject of acual value PZD B1a.3 16 no Immnediaely x

BE1E C3.FE| T=PD_Mapping_Object 5 5. ohject of actual value PZD prog 16 no Immedately X

BE16 C3.FE|_T:PDO_Mapping_Object 6 fi. ohject of aciual valee PZ0D B1as 16 no Immedately X

BELT C3.FE| T:PO_Mapping_Object 7 7. ohject of aciual valee PZ0D B1aa 16 no Immedately X

BE1E C3.FE|_T=PO_Mapping_Ooject 8 E. ohject of actual valee P20 B1ay 16 no Immedaely X

2002 C3 FesdFomvand_Acce Accelermbion feednyan 4002 0:2101.2 (W3 1:] no R LA
20104 23 FesdFonyvand_Cument Cument feediorvand 4004 021014 16 no WE R |x
20105 | C3.FesdFonvand_lerk Jetk feediorwand 4005 021015 16 no WP X X |x
20101 C3 FesdFomward_Speed elociy feedioraand 4001 0:2101.1 16 no WP LA A
201018 | C3.FesdFomand_Voltage ‘oltage feedfonwand 16 no WP B
11417 C3.GEAR_achual_mastemposiion Position input value for Gearing C4 3 no - £ |X X
4024 C3 Limit_Cumenthegative Iapimum pemnizsibie negatve curent 320 h200C 118 no WP £ |® X
4023 C3.Limit_CurentPositive Maermum pemissible positive cument 319 2008 118 no VP R |x
4022 C3 Limit_SpesdMegaties Maermum pemissible negatve spesd 318 2004 (il no VP o lE | X
4021 C3 Limit_SpesdPosite Maernum pemissible posite speed 317 02008 (il no VP o lE | X
410.3 C3 LimitPosifion_Negatwe Megative SW travel lmit 322 0:207D.2 C4.3 no Immediaely RN
4102 C3 LimitPosiion_Posifve Postive Trawvel Limi | 020701 C4.3 no Immediately £ |5 |x
01 C3 Mulitumernulaion_Status Stas of the Multium emulaion 11 no - £ |X X
2005 C3.MomFaciory2 Amay Col2 Scaling factor recpe amays column 2 3555 20205 V2 no Immedaely x| X
2002 C3.MomnFaciory2 Positon Sealing factorfor Y2 positons 3852 020202 V2 no Imrnedaely L
2001 C3.MomnFaciory2 Spesd Saoaling factorfor Y2 spesds 3251 020201 V2 no Immedaely x| X
2003 C3.MomFaciory2 Vokage Sealing factorfor Y2 wokages 3553 20203 W2 no Immediately X |X
204 C3 MomFacioryd_Amay_Coll Sealing factor recpe amays column 1 504 20214 W2 no Immedately X |X
2011 C3.MomFactoryd_Spesd Sealing factor for ¥4 spesds 3581 020211 W2 no Immediately XX
203 C3.MomFacioryd_Vokage Scaling factorfor ¥4 wotages 3583 2021.3 2 no Immediately x| X
201 C3.Clniecilr_Chjekts—=FLASH Siore chjects pemnanendy (bus) 328 27 118 no Immedately x| X
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20,10 C3.0bjecilr_ReadObgcs Read objects from Flash 18 ng Immadiately oK |x
20.11 C3.ObjeciDir_WiiteChjecs Save object permanenty 118 ng Immeadiately nolx |x
4203 23 Posioningéoouracy FolowingEmoeTmeout | Folowing Emer Tme x| 02068 U6 ng Immediately no|x X
4202 C3 Positionngéoouracy_FolowingEmodWindow | Following emer imit 330 2065 C4 3 no VP A I
4206 3. Positonngfccuracy_PostionReached Position reached 132 no - RN
4201 C3 . Posttionngfocuracy_Window Pesttioning window for postion reached 32 OxE067 C4 3 no VP X |® |X
4207 C3 Positionngacouracy WindowTme In Pesifion Window Trme 328 wZ06e (W3 1] ng Immadiately oK X
21207 3. 5peedCbsener_DisturbancefddiionEnable | Swich w ensble dsubance compensation BOCL ng VP oK X
21205 3. 5peedCbsener_DisturbanceFier Time constant dsturbance fiker U3z ng VP oK X
21201 C3.5peedCbsaner_TimeConstant Fapidty of he sped monior U3z ng VP nolx |x
6825 C3.5taushecd_Aciusl Status of achual acedlemation unfikered 132 no X o|xX X
BA2.6 C3 Sisusiocd_ActualFiter Siatus of fitered achual acceleration 132 no i o|x K
6824 C3.Siausdccd_Cemandyalue Stas demand acceleration 325 0200E 132 no A A
6E27 C3.Siaushocd_FesdFomardiocc=l Status acceleraton feed fonvand C43 no X% X
G332 C3.5tausCument_Actusl Status of achual cument RME (tomue producng) E2 6 yes i oKX
6238 23.5iausCumeni_ContmDeviatonly Status of conro! devation of curent confol EMS c4 3 ng oK X
628.14 3. 5ausCument_FeedFomordZumentlerk Staus of curent mns and jerk feedicrarand c4 3 ng no|x X
Gaap C3.StusCumrent_Phasell Status of cument phase U C4 3 no b I A
633.10 C3.5tsusCurrent_PhasaV Status of curent phase WV C2 3 no X o|xX X
6331 C3 . SisusCument_Reference Status of sefpoint cument RMS forgue foming) E2 G no i o|x K
633.13 C3 SisusCument_Referencelerk Status of demand jerk setpoint generator Ca 3 no i o|x K
G33.11 C3.SiausCument_ReferenceV/oltageUg Status of cument control contro sigral C43 no X% X
6231 C3.5iausCevice_AciualCument Status of aciual cument value 112 0077 2 B wes nolx |x
6332 C3.5zusDevice_AsusiDesiceload Siatus of device utlization 334 02011 E2_f no R
6833 3. 5iausDwevice_AciusiMotorLoad Stas of long-temn modor lad 335 a2 E2 @ ng no|x X
6834 C3.SisusDevice_DynamichotorLoad Status of shot-4em motor oad E2 & no A I
6835 3. SisusDevice_ObsenedDisturbance Status of dbsenved disturbance Ca 3 no LR
G224 C3.SisusFeedback_EncoderCosine Status of analog input cosine 132 no XX X
G223 C3.5izusFeedback_EncoderSine Status of analoginpui sne 132 ng oK X
fa22 C3.5ausFeedback_FeedbackCosneDSP Status of cosine in signal processing 132 ng oK X
g22.1 C3.5izusFeadback_FeedoackSineDEP Status of sing in signal processng 132 ng oK |x
G225 C3.5iausFeedback_FeedoackVoltage[Vop] Status of feedhack leve c4 3 ng nolx |x
6805 C3.5isusPositon_Actual Status actual postion 28 OxE064 C2 3 WES X o|xX X
680.13 C3.SisusPosition_Actua/aueContmoller Staus aciua position without absolute reerence Ca 3 no LR
6804 C3.ZausPosition_Demandaue Staus demand positon 323 E0FC Ca 3 no LR
63012 C3.SisusPosition_Demand\/aueContoler Status demand positon without shsoute reference C4 3 no XX X
620.11 3. 5iausPosition_Encodernput2£y Status of encoderinput 0 (24V) C4 3 ng nolx |x
62010 23.5iausPosition_Encodernputsy’ Status of encoder ingut 0 (5V) [ no oK X
6306 C3.5t3usPesidon_FollowingSmar Siatus of ielowing emor 100 OE0F4 C4 3 WEL X o|x X
6815 C3.StausSpeed_Actusl Status acual spesd unfhered B OwE06C C2 3 WES XX X
6817 C3.5iausSpeed_Actusl_v2 Status of the actual speed in the Y2 format & 02023 2 WES XX
G818 C3 . SiausSpeed_Actusl_ve Staus of the actual speed in fhe Y4 format 17 02024 4 wEs - XX
&818 C3.5iausSpeed_ActuslFitersd Status actual spesd fikersd C43 e X% X
681.12 C3.5iausSpeed_ActualSealed Fitered actual speed C43 no X% X
68113 £3.5izus5peed_DemandScaked Sepont spesd of e setpoint penession c4 3 ng nolx |x
681.10 C3.5iausSpeed_Demand SpeedConingler Staus dermnand speed controller input c4 3 ng nolx |x
6214 £3.5ausSpeed_DemandValue Staus demand speed of s=point generator 324 O206B c4 3 ng no|x X
G816 C3.ZausSpeed_Emor Status comnel deviaton of spesd 1M 2027 C4 3 e XX X
68111 C3.SisusSpeed_FeedFomardSpesd Status speed feed onwand C4 3 no A A
G432 C3 Sisus Temperature_Motor Staus of motortempemture 330 02013 UG no i o|x K
G241 C3.5usTemperaure PowerSiage Status of power ouput stage temperaure 137 2014 (W3 1] ng oK X
G353 C3.5sus\ otage_Anaoghpul Status of analoginput 0 23 2025 2 e X% X
6254 C3.5izus=Veltape_Analoginput! Status of analog input 1 102 2026 2 wes nolx |x
E85.1 C3.SisusVoltape_AuianVoltape Status of awdliary witage ¥l C200F E2 G no XX X
6352 C3.5izus\oltape BusViolEge Staus DC bus wohage 327 2078 E2 @ ng no|x X
1 C3ValdPammeter_Global Set objecks to walid 33310 2ME10 | L6 no Immedately LR
C3Amay.Coll_Rowll arab'e Colurmn 1 Row 1 1303411 0:2301.1 4 e Immediately LR

C3Amay Colli_Rowd2 arahble Column 1 Row 2 1315412 | Dx23012 4 e Immediatehy XXX

C3Amay. Coll1_Rowld Varable Column 1 Row 3 1327413 0:2301.3 4 s Immeadiately oK K

CaAmay Collt_Rowls Varabie Colurnn 1 Row 4 13314 | 023014 4 e Imrediately X olx |X

C3Amay Colll_Rowls Varable Column 1 Row 5 13403415 023015 4 wes Immeadiately nolx X
C3Amay.Coll2_Rowdl Warab'e Colurmn 2 Row 1 1353421 0:2302.1 2 WES Immediately XX )X

C3Amay Coll2_Rowd2 arable Column 2 Row 2 1383422 | Dx23022 2 WES Immediately XX )X

C3Amay CollZ_Rowdd arable Column 2 Row 3 1375423 | 023023 2 WES Immediately L

CaAmay Colll2_Rowls arabie Colurnn 2 Row 4 1380424 | 023024 2 yES Imrnediately LA A
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C3Amay Coll2_Rowls Varable Column 2 Row & 12873425 23025 2 wes Immadiately iolx |X
C3Amay.Coll_Rowll Varable Column 3 Row 1 14073431 23031 118 wes Immadiately nolx X
C3Amay Coll_Rowl2 ‘Warable Column 3 Row 2 14173432 02303.2 18 wes Immeadiaely no|x X
C3Amay.Colld_Rowdd Vanable Column 3 Row 3 1423423 | Dx2302.3 I WES Immediately A I A
CaAmay Collld_Rowls Vanable Column 3 Row 4 14373424 | 023034 16 EE Immedanely L
C3Amay Colld_Rowd5 arable Coumn 3 Row 5 14473435 | 23035 I WES Immediately £ |6 X
CaAmay ColM_Rowli anable Column 4 Row 1 14373441 23041 I WES Immediately A A
C3Amay CollM_Rowd2 anable Column 4 Row 2 1483442 | 232 I e Immediately i |x% X
C3Amay Coll4_Rowld Varable Coumn 4 Row 3 14773443 233 118 wes Immadiaely nolx X
C3Amay Coll4_Rowls Varable Coumn 4 Row 4 1487344 4 234 4 118 wes Immadiately nolx X
C3Amay Colld_Rowld ‘Warable Coumn 4 Row 5 1487344 5 2IME 18 wes Immeadiaely no|x X
C3Amay.ColD5_Rowll anable Column & Row 1 1503451 23051 I e Immediately LR
C3Amay Coll5_Rowd? Vanable Column 5§ Row 2 15173452 | D«23052 I WES Immediately A I
C3Amay Coll5_Rowdd arable Coumn 5 Row 3 15273453 | «2305.3 I WES Immediately £ |6 X
C3Amay ColD5_Rowld arable Coumn 5 Row 4 15373454 | 23054 I WES Immediately A A
C3Amay Coll5_Rowds Varable Coumn 5 Row 5 15473455 | 23055 I e Immediately i |x% X
C3Amay.ColDd_Rowll Varable Column 6 Row 1 15873481 2306.1 132 wes Immadiately nolx X
C3Amay ColDd_Rowd2 ‘Varable Column & Row 2 1587346.2 023062 132 wes Immadianeky nolx X
C3Amay ColDd_Rowld ‘Varable Column & Row 3 STIME3 02306.3 132 wes Immadiaely nolx X
C3Amay ColDd_Rowld anable Coumn & Row 4 158034064 | 023064 132 e Immediately LR
C3Amay ColDd_Rowds anable Coumn & Row 5§ 15903485 | D«2306.5 132 WES Immediately X |xX X
C3Amay CollT_Rowdl anable Calumn 7 Row 1 1807347 1 23071 132 WES Immediately olx X
C3Amay Coll7_Rowd2 anable Coumn 7 Row 2 18173472 | 23072 132 e Immediately i |x% X
C3Amay Coll7_Rowdd anable Coumn 7 Row 3 18203473 | 23073 132 e Immediately i |x% X
C3Amay Coll7_Rowl4 Varable Coumn 7 Row 4 1837347 4 02307 4 132 wes Immadiately nolx X
C3Amay CollT_Rowls ‘Warable Coumn 7 Row 5 18473475 023075 132 wes Immadianeky nolx X
C3Amay.ColD2 Rowdl ‘Varable Column & Row 1 18573481 2308.1 132 wes Immadiaely nolx X
C3Amay.ColD8_Rowd2 anable Coumn & Row 2 1803482 | D«230B2 132 WES Immediately X |xX X
C3Amay Colli_Rowdd Vanable Column & Row 3 1673483 | «230B.3 132 WES Immediately A I
C3Amay ColD8_Rowld anable Column & Row 4 18853484 | «230B4 132 WES Immediately £ |6 X
C3Amay Coll3_Rowds Vanable Column & Row 5 18974285 | 23085 132 WES Immediately A A
C3Amay Coll?_Rowll Vanahble Calumn 8 Row 1 17003421 [230E.1 132 e Immediately X |x X
C3Amay Colld_Rowl2 Varable Column B Row 2 17173482 23082 132 wes Immadiately nolx X
C3Amay Coll?_Rowld ‘Varable Column B Row 3 17273403 023083 132 wes Immadiaely nolx X
CaAmay Coll Rowls arabe Coumn @ Row 4 1733484 | 023004 132 WEL Immadately RN
C3Amay Colld_Rowds arable Coumn @ Row 5 17403425 | D«2300.5 132 WES Immediately X |xX X
CRAmay Indirect Col01 Indirect izhle access Coumn 1 181 2311 4 WES Immediately £ |6 X
CRAmay Indirect Coll2 Indirect izhle access Coumn 2 182 2312 2 WES Immediately LR
C3Amay Indirect Sol03 Indirect tzble access Coumn 3 183 02313 I e Immediately i |x% X
C3Amay Indirect Cole Indirzct iable access Coumn 4 124 2314 18 wes Immadiately iolx |X
C3Amay Indirect Coll5 Indir=ct iable access Coumn & 85 i ] 118 wes Immadiately nolx X
C3Amay Indirect Cold Indir=ct iable access Coumn & 183 26 132 wes Immadiaely nolx X
ClAmay.Indirect Col07 Indirect tzble access Coumn T a7 027 132 WES Immediately X |xX X
C3Amay.Indirect Coll2 Indirect tzble access Coumn B 183 0231E 132 WES Immediately X |xX X
CRAmay Indirect ColD3 Indirect izhle access Coumn B 188 L231E 132 WES Immediately £ |6 X
CRAmay Pomter_Row Poinier o tahle row 180 (2300 U1G WES Immediately LR
C3Pus AuteCommutatonContrel_inftalCument | Startcument of automaic commutaton 32 no VP X |x X
C3Pius DevezConro|_Conirobvord_1 CW control word 1 04D W2 wes Immedaely - x| X
C3Pius DeviceConrol_Conirokvord 2 Conitrgl word 2 3 L201E W2 wes Immedanky - X |X
11005 C3Pius DeviceComrn]_Opemioniode Cperaing mode 127/30 w2060 18 wes Immadiaely - x| X
10005 C3Pus DeviceSiste_Actud Dperationiode Cperaing mode disolay 123 OxE061 I WES Immnediately - X |X
10003 C3Pus DeviceSiate_StEtusword 1 Status word SW 2 OxE041 W2 WES Immediatehy - XX
10004 C3Pus DeviceSiate_SEuswon 2 Sitatus word 2 4 L2MGC W2 WES Immediatehy - X |X
5501 C3Pius EmorHistory_LasEmor Cument emar inj 1158470 | DeB03F 05151 WES A A
02001
11418 C3PIus. GEAR._acua_master_speed Master speed for Geanng c4 3 ng nolx X
1130.1 C3PIus HOMING _acc=| Aceelerbion | deceleration MM un 300 2004 32 ng Immediately oK X
1130.7 C3PIus HOMIMNG _edpe sensor_dsiance Inidztor adjusiment 304 02000 c4 3 ng Immedarly nolx X
11302 C3PIus HOMING _jerk Jerk for homing 357 0:2ME a2 no Immediately RN
11304 C3PIus HOMING_made Adjustng the homing mode 302 02098 U16 no Imrnadanely X o|x X
11303 C3PIus HOMING _speed Speed for homing 3 O208E.1 Ca 3 no Immediately £ |6 X
2012 C3Pius.Nom Facioryd_Pesition Scaling factorfor ¥4 positions 3582 20212 W2 no Immediately - X |X
503 C3Pus PLC_ActualCydeTime Status of cyde tme of the conrol program 353 0201F 2 UG no - X |X
504 C3PIus PLC ActualCydleTimelax Status of maxmum cycie tme 354 L201F.3 93 1] ng Immadiately - X |X
801 C3PIus PLC DemandCycleTime Cycle tme speciication 352 201F A U6 ng Immadiately - x| X
Bag2 C3Pius Profious_Baudsiz Baud rate U3z ng - X |-
E303 C3Pus Profious_Modefddress hode address Bia U16 no - X |-
B30 C3Pus Profious_Protocal P O-type selecton swich U16 no Immedately - xo|-
E306 C3Pus Profious_ StandardSignal Table L=t of Profidive standard signals EX3x U1G no - - x |-
B304 C3Plus. Profious_TelegramSeisct Telegram selecion swich E22 UG no Immediately - x |-
1521 C3Plus RemoizAnaloginput_ID P12 analog input 0 20821 I8 e Immediately - - X
1522 C3Pius. Rernotzfnaloginput_I1 P12 analog mput 1 20822 118 wes Immadiately - - X
1523 C3Pius. Remotzdnaloginput_[2 PIZ analog input 2 20823 il wes Immadiaely - - X
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524 C3Pus. Rernoisdnaloginput_I2 P12 analog ingut 3 20824 18 yes Immadiaely - - X
153.1 C3Pius. RemotsdnalogCuput 00 PIZ analog output 0 h2083.1 18 yes Immedately - - X
1532 C3PIus. RermossdnalogOuput_21 P12 analog ouiput 1 20832 118 yES Immediaely - - X
1533 C3Pus. RemostnalogOuput_02 PIZ analog cuwtput 2 20833 18 yes Immadiaely - - X
1534 C3Pius. RemotsdnalogCuput 03 PIZ analog output 3 20834 18 yes Immedately - - X
1501 C3PIus. RernoszDigingut 10_15 Digital P12 inputs 015 h2080.1 Wz yES Immediately - - X
1502 C3Plus. RernodeDiginput_118_31 Digital P2 inpues 18.0.31 20802 W2 yes Immedatehy - |- |E
1503 C3Plus. RernodeDiglnput_[22 47 Digital P2 inpues 32..0.47 020803 W2 yes Immedately - |- X
1504 C3Plus. RernodeDiglnput_M2_83 Digital P10 inpuss 48,0062 20804 V2 yes Immedately - |- |E
1511 C3Plus. Remmot=DigOutput_00_15 Digital P10 outpues 015 0:2081.1 W2 yes Immediately - |- |®
1512 C3Plus. RernoazDig Cutput_018_31 Digital P2 outpues 18.0.31 [2081.2 W2 yes Immediately - |- X
151.3 C3Plus. RernoaeDigCutput_032_47 Digital PO outpues 32,047 20813 V2 yes Immedately - |- |E
1514 C3Pius. RernodzDigCutput_C48_63 Digital PO outpues 48,063 20814 W2 yes Imrmediatety - |- |E
GB0B C3Pius. StausPostion_Actual 4 Status posdon acual value in the bus fomat ¥4 119 2022 4 yes - X |XK

External device connection manual for TOP Design Studio 15 / 17



TO,

ERI2 e B X
Touch Qperation Panel

Objects for the process data channel

Mo, Chbjzciname Object FHU PZD CAN Mo. FO Bus W
fomnat width
2344 Sefpoint for analog ouput D C3 AnglogDutput]_Demand/aue 24 PELVPAD | 2012 RTPOO 118 1
G364 Setpaint for analog ouput 1 C3.AnalogOutput!_DemandVaue 103 PEDPAD | ;2020 RITPDC 118 1
1202 Status of digial inputs C3.Digitalinput_Value 21 PE| o3 100. 1 TFDO V2 1
1212 nputword of 'O ootion 3. DigitalInputAcdimon_Value 175 PE D3 100.2 TPOO V2 1
133.3 Qutput word for WD option C3.Digital Outpuiidcition_Value 176 PEDPAD | DoA3002 RITPOC W2 1
20201 Position frem exema signal scume 3. ExtemalSignal_Posiion PE TPDO C4 3 2
20202 Speed from extemal signal source C3.ExemalSignal_Speed PE TPDO C4_3 2
8382 Status of actua cument RMS (tormue producing) | C3.5usCurent_Actual PE TPOC EX 6 1
8831 Stahe of actua cument value C3.SahusDevce_ActualCument 112 PED D07y TPDO E2 & 1
a0.5 Status actual position C3.5atusPosition_Actua ] PE| D064 TFDO ] 2
Ba0.6 Sitatus of following eror C3.5ausPosition_FolowingEmor 100 PE| DA0F4 TFDO ] 2
6815 Status aciual speed unfitered C3.5ausSpeed Acksal 8 PED DnA06C TFDO Cc4.3 2
8817 Status of e actual spead n the V2 fomat 3 SausSpeed Actal Y2 & PE 02023 TPOO 2 1
8818 Status of e actua speed in the Y4 fornat C3.5ausSpeed_Actial_v4 17 PED 2024 TFDO 4 2
6816 Status conol deviation of speed C3.5tatusSpeed_Emor 1M PED 2027 TFDO C4 3 2
8a5.3 Stahs of andog input 0 C3.5ahusVoltage_Analoginpuid 23 PE 2025 TPDO 2 1
8354 Status of analog input 1 3 SahusVioltage Analoginputt 102 PE D226 TPOO 2 1
1801.1 Variable Column 1 Row 1 C3Amay Coll1_Rowdl 1303411 [ PEDPAD | 2301 RITPDC 4 2
18012 Variable Column 1 Row 2 CAmay Coll1_Row(2 133412 | PEDPAD | 23012 RITPDC ¥4 2
18013 \Variable Column 1 Row 3 C3Amay Coll1_Rowl3d 1323413 | PEDPAD | 23013 RITPOO 4 2
19014 Variable Column 1 Row 4 CAmay Coll1_Row(4 1333414 [PEDPAD | 023014 RITPOC 4 2
1801.8 Variable Column 1 Row S CAmay Coll1_RowlS 1MEE [ PEDPAD [ 23015 RITPDC 4 2
18021 Variable Column 2 Row 1 C2Amay Coll2_Rowdl 1363421 | PEDVPAD | Db2302 RITPDC Y2 1
18022 \Variable Column 2 Row 2 C3Amay Coll2_Rowld 1383422 |PEDPAD | 23022 RITPOO Y2 1
18023 Variable Column 2 Row 2 CAmay Coll2_Rowl3 1372423 | PEDPAD | 23022 RITPOC ¥2 1
19024 \Variable Column 2 Row 4 C2Amay Coll2_Row(4 1383424 |[PEDPAD | Dn23024 RITPDC Y2 1
18025 \Variable Column 2 Row 5 C3Amay Coll2_Row(S 1382425 | PEDPAD | 23025 RITPOO Y2 1
18031 Variable Column 3 Row 1 C3Amay Colld_Rowll 1403431 | PEDWPAD | Dn2303 RITPOO 118 1
19032 Variable Column 2 Row 2 CAmay Colld_Rowll 1412432 [ PEDPAD | 23022 RITPDC 118 1
18032 \Variable Column 3 Row 3 C2Amay Colld_Row(d 1423433 |PEDPAD | 23022 RITPDC 118 1
18034 Variable Column 23 Row 4 C2Amay Colld_Row(4 1432434 | PEDPAD | 23024 RITPOO 118 1
18035 Variable Column 2 Row 5 C3Amay Colld_RowlS 1442435 | PEDPAD | 23025 RITPOC 118 1
1904.1 Variable Column 4 Row 1 CAmay Colld_Rowll 14823441 [ PEDWPAD | 2304 RITPDC 118 1
19042 Variable Column 4 Row 2 CAmay Coll4_Row(2 1463442 | PEDPAD | 23042 RITPDC 118 1
18043 \Variable Column 4 Row 3 C3Amay Colld_Rowl3d 1473443 | PEDPAD | 23043 RITPOO 118 1
19044 Variable Column 4 Row 4 C3Amay Colld_Row(4 1483444 [ PEDPAD | 23044 RITPOC 118 1
19045 Variable Column 4 Row 5 Camay Colld_Rowld 1403445 | PEDPAD | 23045 RITPDC 118 1
18081 Variable Column 5 Row 1 C3Amay Colld_Rowll 1502451 [ PEDWAD | 2305 RITPOO 118 1
18052 \Variable Column 5 Row 2 C3Amay Colld_Rowl?d 1512452 | PEDPAD | 23052 RITPOO 118 1
9052 \Variable Column 5 Row 2 C2Amay Colld_Rowd 1523452 |PEDPAD | 23053 RITPDC 118 1
0054 \Variable Column 5 Row 4 CAmay Colld_Row(4 1533454 |PEDPAD | 23054 RITPDC 118 1
1805.5 \Variable Column 5 Row 5 C3Amay Colld_Row(s 1542455 |PEDPAD | Dh23055 RITPOO 118 1
18081 Variable Column & Row 1 C2Amay Colld_Rowll 3401 | PEDPAD | 2303 RITPOC 132 2
19082 Variable Column & Row 2 CAmay Colld_Rowll 3482 |PEDPAD | 23022 RITPDC 132 2
9062 Variable Column & Row 2 CAmay Colld_Rowd 1573482 | PEDPAD | 23082 RITPDC 132 2
3064 Variable Column & Row 4 C3Armay Colld_Row(4 1582464 | PEDPAD | 23024 RITPOO 132 2
18065 Variable Column & Row 5 CAmay Colld_RowlS 1582465 |PEDPAD | 23085 RITPOC 132 2
1807.1 Variable Column T Row 1 CAmay Coll7_Rowdl 180347.1 | PEDVPAD | Du2307 RITPDC 132 2
18072 Variable Column 7 Row 2 C3Amay Coll7_Rowl?2 1813472 | PEDPAD | b23072 RTPDO 132 2
18073 Variable Column 7 Row 3 C3Amay Coll7_Rowl3d 1823473 | PEDPAD | Db23072 RTPDO 132 2
19074 \Variable Column 7 Row 4 C2Amay Coll7_Row(4 1833474 |PEDPAD | 23074 RITPDC 132 2
180758 Variable Column 7 Row & C2Amay Coll7_Row(s 1843475 | PEDPAD | 23075 RITPOO 132 2
1808. Variable Column 8 Row 1 C3Amay Colld_Rowll 185248.1 [ PEDWAD | w2308 RITPOO 132 2
18082 Variable Column 8 Row 2 CAmay Colld_Rowl2 1862482 | PEDPAD | 23082 RITPOC 132 2
0082 \Variable Column 8 Row 3 C3Amay Colld_Rowd 1873482 |PEDPAD | Dn23082 RITPDC 132 2
8084 Variable Column 8 Row 4 C3Amay Colld_Row(< 1882484 |PEDPAD | 23024 RITPOO 132 2
18085 Variable Column 8 Row 5 C3Amay Colld_Rowls 1882485 |PEDPAD | Du230E5 RITPOO 132 2
19081 Variable Column @ Row 1 C3Amay Colld_Rowll 1703480 | PEDPAD | Du230201 RITPOC 132 2
190082 Variable Column @ Row 2 CAmay Colld_Rowl2 1712482 | PEDPAD | 23022 RITPDC 132 2
808.2 Variable Column @ Row 3 C3Amay Colld_Rowld 1723483 | PEDPAD | 230232 RITPOO 132 2
3064 Variable Column @ Row 4 C3Amay Colld_Rowl4 1733484 | PEDPAD | 23024 RITPOO 132 2
1800.5 \Variable Column @ Row 5 C2Amay Colld_Rowls 1743405 |PEDPAD | 23025 RITPDC 132 2
1810, ndirect table acoess Column 1 C3Amay-indrect_Caoll1 3 PEDPAD | ;2311 RITPOO 4 2
9102 ndirect table acoess Column 2 C3Amay ndrect Coll2 182 PEDPAD | 2312 RITPOO 2 1
2102 ndirect table acoess Column 2 C3Amay indrect Coll3 183 PEDPAD | 3312 RITPOC 118 1
2104 ndirect table acoess Column 4 C3Amay indrect Coll4 184 PEDPAD | ;2314 RITPDC 118 1
905 ndirect table acoess Column & CAmay-indrect CollS 188 PEDPAD | 2315 RITPOO 118 1
3108 ndirect table acoess Column @ C3Amay ndrect Colld 186 PEDPAD | 2318 RITPOO 132 2
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Mo Chjectname Object PHU PZD CAN MNao. FD Bus W
fomniat wnictth
19107 ndirect fable access Column 7 ClAmay indrect Col07 187 PEDVPAD | Dn2317 RTPDO 132 2
19108 ndirect lable access Column 8 CaAmay ndrect Col03 138 PEDPAD | De2318 RTPOO 132 2
19102 ndirect table acoess Column @ CaAmay ndrect ColD8 138 PEDPAD | In2312 RTPODO 132 2
19001 Pomier o tsbie row ClAmay Pomer_Row 140 PEDVFAD | Dn2300 RTPDO (W31} 1
11002 W canrol word C3PIus. DeviceConirol_Controwond_1 1 PEDPAD | DefD4D RTPOO V2 1
11004 Control word 2 C3PIs DeviceConrol_Controlword_2 3 PELPAD | w2018 RTPOO V2 1
11005 Cperating mode C3PIus DeviceContol_Operationhlode 127820 PEDVPAD | DwADED RTPDO 118 1
10005 Cperating mode display C3Plus DeviceSiae AcuaDperationiiode 128 PEDVPAD D061 RTPDO 118 1
10003 Status wiom SW CAPIs DeviceSiate Statuswond_1 2 PEDPAD | DAl RTPOO W2 1
10004 Status wiord 2 CaPhs DeviceSiate Statusword_2 4 PEDPAD | De201C RTPDC V2 1
5501 Current emor{n) CaPhs EmorHistory_LastEmor 1158470 | PE DeR03F TPOO (W) 1] 1
20101

PI0 analog input D CaPIes. Remotesfnaleginput 10 PEDVPAD | Dn20E21 RTPDC 118 1
PI0 analog input 1 C3Plus. RemotsAnaloginput |1 PEDPAD | Dn2DE22 RTPDO 118 1
PI0 analog input 2 CAPIs. Remot=sfnaoginput (2 PEDPAD | De2DE23 RTPOO 118 1
PID analog input 3 CAPhs. Remotsfnaoginput_[2 PELPAD | Dn2DE2 4 RTPOO 118 1
PI0 analog ouput D C3PIus. RemoteAnalogOuiput 0D PEDWAD | Db2DE31 RTPDO 118 1
PI0 analog ouput 1 C3PIus. RemoteAnalegOuiput_ 01 PEDWAD | e2DB32Z RTPDO 118 1
PIO analog ouput 2 CaPIus. RemoteAnalogDuput 02 PEDWAD | e2DB32 RTPDO 118 1
PI0 analog ouput 3 C3PIus. RemotefnalegOuiput 03 PEDWPAD | e2DB34 RTPDO 118 1
Cigial PIO inputs 0...15 CaPhes.RemateDiginput_10_15 PEDPAD | Dn20B0.1 RTPDC V2 1
Cigisl PIO inputs 16.0.31 CaPhes.RemoteDigihput 11631 PEDVPAD | De20B02Z RTPDC W2 1
Cigisl PIO inputs 32.047 C3Plus. Remoteligihput_[32 47 PEDFAD | Dn20B02 RTPDO VI 1
Cigial PIO inputs 48083 CAPhs. RemoeDiginput_48_83 PEDPAD | Dn20B04 RTPOO VI 1
1.1 Digial PIO cutputs 015 CaPhs. Remot=DigCutput_O0_15 PEVFAD | Dn20B1.1 RTPOO W2 1
152 Digial PIO cutputs 18..0.21 CaPhs. RemaoteDigCutput_ 011831 PEDPAD | e2DB1.2 RTPODC V2 1
1513 Digial PIO cutputs 32.047 CaPhus. RemaoteDigCutput_C32 47 PEDFAD | e2DB1.2 RTPOC V2 1
1514 Digial PIO cutputs 43..083 CaPhus. RemaoteDigCuiput 048 63 PEDPAD | Dn2DB14 RTPDC V2 1
230k Status pesition actual value in the bus format Y4 | C3Pus.StahusPosibion_Aciual 4 119 PED 2022 TPOO 4 2
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